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1 Introduction

1.1 Overview

What are TEX and LATEX?

∙ TEX is a typesetting application.

∙ It uses primitives to determine how to put text on a page.

∙ Very complicated!

∙ Formats are provided that translate easy to use commands into the low level
primitives required by TEX.

– Plain TEX

– LATEX

– ConTeXt

– . . .

∙ Think of LATEX as an interpreter between you and TEX.

What Else is There?

XeTeX/XeLaTeX: based on a merger of TEX and modern font technologies.

∙ Supports Unicode character sets.

∙ Supports bidirectional typesetting.

LuaTeX: TEX-like engine with a lua interpreter built in.
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What do we need to use LATEX?

∙ A text editor (e.g. notepad).

∙ A PDF viewer (e.g. Adobe Reader).

∙ A TEX distribution (e.g MiKTeX or TeX Live).

(Notepad isn’t a particularly good editor. It’s much better to use an editor that’s
TEX-aware.)

Workflow

Edit
.tex
File

Any
Errors?

View
PDF

Any
Changes?

Done

LATEX

Yes

No

Yes

No

Installation

∙ DVD ROM (easiest method):

– Available free to members of the TEX User Group (TUG) or local groups such
as the UK TEX User Group (UKTUG).

UKTUG: new membership for 2010 costs $10. Visit http://uk.tug.org/
Membership/ to join. TUG: early bird membership is $85. After 31st March
2010, $95. Visit http://www.tug.org/join.html to join.

– Can be purchased from http://www.tug.org/store/

∙ Download it from the Internet: http://www.tug.org/

Text Editors Available for Windows

TeXMaker Free http://www.xm1math.net/texmaker/
TeXnicCenter Free http://www.texniccenter.org/
WinEdt Shareware http://www.winedt.com/
WinShell Free http://www.winshell.org/

We will be using TeXMaker.

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 2
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Warning!

∙ Word processors can instill bad typographical habits. Examples:

– Fully justifying text without hyphenation — this can produce large areas of
white space between words.

– No paragraph indentation and blank lines between paragraphs. (This is be-
coming more accepted, especially for HTML documents, but it’s still consid-
ered amateurish by some.)

∙ TEX follows many typesetting rules.

∙ People changing from word processors to TEX often get frustrated because TEX
makes it difficult (but not impossible) to implement these bad habits.

1.2 Getting Started

Special Characters

∙ With a word processor, you can type any symbol on your keyboard.

∙ TEX has special characters. These are symbols that have a special meaning and
should be used with care!

\ { } % ~ & # $ ^ _

∙ If you actually want to produce one of those symbols, you need to use a command:

\textbackslash \{ \} \% \textasciitilde \& \# \$ \textasciicircum \_

Spaces

∙ TEX treats multiple spaces as a single space.

∙ By default, the space between sentences is slightly larger than the space between
words. This can be switched off using \frenchspacing.

∙ New line characters are treated as a space.

∙ Paragraph breaks should be indicated by a blank line. (By default, there won’t be
a blank line in the PDF file.)

∙ LATEX automatically indents paragraphs, except for the first paragraph after a
section heading.

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 3
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A Simple Document

Example 1.

\documentclass[a4paper,12pt]

Class options

{article}

The class name.Preamble
\begin{document}
% This is a comment
This is a simple
document\footnote{with a footnote}.

This is a new paragraph.

The document.

\end{document}

Exercise 1. Create the above document. To get started, do:

1. Start→Programs→CMP Development Tools→ LaTeX→TeXMaker GUI

2. A command prompt will appear. Wait for it to go away.

3. In TeXMaker, select File→New (or click the “New” button.)

4. Select Wizard→Quick Start.

5. Select 12pt and a4paper and click “Okay”

6. Type in the above code.

7. Save the document (e.g. call it exercise.tex).

8. Select Tools→PDFLaTeX.

9. Check the messages in the lower right hand box.

10. If there are no errors, start up Adobe Reader and load the new PDF file.

2 Classes and Packages

2.1 Document Classes

Document Classes

∙ The document class sets up the general layout of the document. For example:

– the format of the headings;

– if the document should have chapters;

– if the title should be on a separate page or above the text on the first page.

∙ The class is specified using

\documentclass[options ]{class-name }

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 4
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Available Classes

∙ There are many classes available for different types of documents.

∙ Basic classes:

article for short documents without chapters;

report for longer documents with chapters, typically single-sided with an abstract;

book for books, typically double-sided with front matter and back matter;

letter for correspondence;

slides for presentations.

∙ The basic classes aren’t very flexible.

Modern Classes

∙ The KOMA-Script classes:

– scrartcl replaces article

– scrreprt replaces report

– scrbook replaces book

– scrlttr2 replaces letter

∙ memoir replaces book and report

∙ octavo replaces book

∙ Presentations (replacing slides):

– beamer (used to create the accompanying slides)

– prosper

– foils

∙ We will be using scrartcl for the rest of the exercises.

2.2 Packages

Packages

∙ A package is a type of “add-on” or “plugin”.

∙ Packages are loaded (in the preamble) using:

\usepackage[options ]{package-name }

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 5
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Example 2.

\documentclass{scrartcl}
\usepackage{hieroglf} provides \textpmhg

\begin{document}
Some hieroglyphics: \textpmhg{Ra}

Needs hieroglf
package
to work\end{document}

What Are Packages For?

∙ A package can provide additional commands. Examples:

– The graphicx package provides a command to include images.

– The parallel package provides commands to typeset text in parallel (for
example, one language in one column and the translation in the next column.)

∙ A package can change the fonts. Examples:

– The mathptmx package will change the serif font to Times.

– The helvet package will change the sans-serif font to Helvetica. (Needs to
be scaled to work with Times.)

∙ A package can redefine existing commands. Examples:

– The datetime package redefines \today to change the format of the current
date.

– The babel package redefines the commands that provide textual labels (e.g.
“Contents”, “Chapter”, “Appendix”).

Exercise 2. To practice loading packages, amend your document so that it uses Times,
Helvetica and Courier. Also change the document class to scrartcl. For example:

\documentclass[12pt]{scrartcl}
\usepackage{mathptmx}
\usepackage[scaled=.92]{helvet}
\usepackage{courier}

\begin{document}
This is a \emph{simple} document. \textsf{Some
sans-serif text.} \texttt{Some typewriter text.}
\end{document}

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 6
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3 Structure

3.1 Titling Information

Title Page and In-Page Titles

∙ The title page is on a page of its own.

∙ The in-page title is at the top of the first page of the document.

∙ Both types are produced by the same command.

∙ The document class and the class options determine whether to use a title page or
in-page title.

∙ Usually, article-like classes have an in-page title whereas book- and report-like
classes have a title page.

Specifying the Title Information

∙ Before you can display the title page or in-page title, you must specify the title
information.

∙ Available commands depend on the class file. For scrartcl the following com-
mands are available:

\title{Title }
\author{Author(s) }
\date{Date }
\titlehead{Titlehead }
\subject{Subject }
\subtitle{Subtitle }
\publishers{Publisher }

Most class files define \author, \title and \date. Some classes may provide other
commands.

Specifying and Displaying the Title Information

∙ Separate multiple authors with \and, for example:

\author{Smith \and Jones \and Brown}

∙ Use \thanks{Text } to provide an attribute, for example:

\author{Jo Bloggs\thanks{Funded by the Creative Arts Council}}

∙ If \date is omitted, the current date is used. To suppress the date use \date{}

∙ Once the information has been specified, display the title using \maketitle.

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 7
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Displaying the Title Page or In-Page Title

Example 3.

\documentclass{scrartcl}

\title{An Example Document}
\subtitle{With a Subtitle}
\author{Me\\University of East Anglia
\and My Shadow\\University of No Where}
\subject{\LaTeX\ Exercise}

Specify information

\begin{document}

\maketitle Display title information
This is a simple document\footnote{with a footnote}.
\end{document}

Notes

∙ \LaTeX produces the LATEX logo.

∙ Spaces are ignored after command names, so \LaTeX Exercise will produce LATEXExercise.

∙ Force a space using \ (backslash space) for example: \LaTeX\ Exercise.

Exercise 3.

∙ Edit your document from the previous exercise so that it has an in-page title.

∙ Once it’s working, use the datetime package to practice loading packages. What
difference does it make?

\usepackage{datetime}

(It only makes a difference if you don’t use the \date command.)

3.2 Paragraph Breaks

Paragraph Breaks
A paragraph break is indicated by a completely blank line or using \par

Example 4.

This is the first paragraph. A blank line is used
to indicate a paragraph break, but that doesn’t mean
that a blank line will appear in the PDF file.

This is the second paragraph.\par This is the third
paragraph.

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 8



An Introduction to LATEX 24/2/2010 & 3/3/2010

Exercise 4. The lipsum package provides dummy text. We’ll use this in the exercises
from now on to pad out the document we’re creating.

Edit your document so that it contains some paragraphs. You will need to add:

\usepackage{lipsum}

Add each paragraph using \lipsum.1 For example:

\lipsum[1]
\par
\lipsum[2]

\lipsum[3]

Changing the Paragraph Indentation and Separation

∙ To change the width of the paragraph indentation use:

\setlength{\parindent}{length }

For example:

\setlength{\parindent}{0.5in}

∙ With the KOMA-Script classes, you can suppress the paragraph indentation and
add blank lines between paragraphs using the parskip class option:

\documentclass[parskip]{scrartcl}

3.3 Sectioning Commands

Sectioning Commands

∙ Article-like classes provide the commands:

\part[short title ]{title }
\section[short title ]{title }
\subsection[short title ]{title }
\subsubsection[short title ]{title }
\paragraph[short title ]{title }
\subparagraph[short title ]{title }

1Actually, \lipsum puts in the paragraph breaks automatically, but for this exercise we’ll pretend it
doesn’t.

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 9
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∙ If the short title is present, it’s used for the table of contents or the page header.

∙ Book and report-like classes also provide the command:

\chapter[short title ]{title }

Suppressing the Section Numbering

∙ Sections/chapters etc are automatically numbered by default.

∙ Use the starred version to suppress the numbering for an individual unit. For
example:

\section*{Acknowledgements}

∙ To suppress all section numbering use:

\setcounter{secnumdepth}{1}

(Use -1 for parts, 0 for chapters, 2 for subsections, 3 for subsubsections etc.)

The book-like classes also provide \frontmatter, \mainmatter and \backmatter.
The \frontmatter and \backmatter commands switch off the chapter numbering (\frontmatter
also changes the page numbering to lower case Roman numerals).

Sectioning

Example 5.

\section{Introduction}
\lipsum[1-2]

\subsection{Sample Subsection}
\lipsum[3]

Exercise 5.

∙ Add some sections and sub-sections to your document.

∙ Try changing the paragraph indentation or try the parskip class option (but don’t
do both at the same time).

∙ Try the following class options and see what effect they have: smallheadings,
normalheadings and pointednumbers.

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 10
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Cross-Referencing

∙ Most things in LATEX that automatically generate a number can be cross-referenced.

∙ Put \label{label } after the command that generates the number. Example:

\section{Introduction}\label{intro}

∙ Put \ref{label } where you want to reference it. For example:

See section \ref{intro} for a brief introduction.

∙ Better to use an unbreakable space:

See section~\ref{intro} for a brief introduction.

∙ Run LATEX twice to get the references up-to-date.

Labels

∙ Occasionally you need to put the label in the argument of the number-generating
command.

Example 6.

\footnote{\label{footnote}Another footnote}

Somewhere else in the document:

See footnote~\ref{footnote} on
page~\pageref{footnote}.

∙ If the label is undefined, LATEX will insert ?? in place of the reference number and
will issue a warning. Check the messages box for any warnings.

Exercise 6.

∙ Add some cross-references to your document. (You can use TeXMaker’s LaTeX
menu to insert the \label command.)

∙ Add the hyperref package (after all other packages):

\usepackage[colorlinks]{hyperref}

The cross-references should now be hyperlinks.

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 11
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Abstract

∙ Abstracts are put in the abstract environment. Example:

\begin{abstract} Start of environment
This is the abstract.
Its style depends on the
document class.

The contents of the abstract

\end{abstract} End of environment

∙ The word “Abstract” will be placed at the start of the abstract if you use the
abstracton class option:

\documentclass[abstracton]{scrartcl}

Table of Contents

∙ Use \tableofcontents where you want the table of contents to appear.

∙ Typically after \maketitle.

∙ Run LATEX twice (occasionally a third run is needed).

∙ By default, different sectional units have different indentations. To display all
section numbering flush-left use the tocleft class option.

Example 7.

\begin{document}
\maketitle
\tableofcontents

Exercise 7.

∙ Add an abstract and a table of contents to your document. (Remember to use LATEX
twice.)

∙ Try the class option abstracton and see what happens.

∙ Try the class option tocleft and see what happens.

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 12
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3.4 Page Headings

The scrpage2 Package

∙ Page headers and footers can be changed with the scrpage2 package, which comes
with the KOMA-Script classes.

∙ There are three basic page styles: empty, scrplain and scrheadings

∙ Page styles can be set using

\pagestyle{style }

∙ To set the style for the current page only:

\thispagestyle{style }

Changing the Header

∙ The inner, centre and outer parts of the header can be set using:

\ihead[plain inner head ]{inner head }
\chead[plain centre head ]{centre head }
\ohead[plain outer head ]{outer head }

∙ The optional argument is used with \pagestyle{scrplain}

∙ The other argument is used with \pagestyle{scrheadings}

Changing the Footer

∙ The inner, centre and outer parts of the footer can be set using:

\ifoot[plain inner foot ]{inner foot }
\cfoot[plain centre foot ]{centre foot }
\ofoot[plain outer foot ]{outer foot }

Example 8. In this document I used:

\usepackage{scrpage2}

\ihead[]{An Introduction to \LaTeX}

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 13
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\chead[]{}
\ohead[]{24/2/2010 \& 3/3/2010}
\ifoot[]{\url{http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/}}
\cfoot[\pagemark]{}
\ofoot[]{\pagemark}
\pagestyle{scrheadings}

Note that the first page has a different page style. This is because \maketitle uses
the scrplain style with the scrartcl class.

3.5 Columns

Two Columns

∙ So far, our example document is a one column document. To change this, use the
twocolumn class option. For example:

\documentclass[twocolumn]{scrartcl}

∙ You can also switch to two column mode using \twocolumn but this will cause a
page break.

∙ For a short block of two (or more) column text within a one column page use the
multicol package.

∙ For a more elaborate layout, you can use the flowfram package.

Parallel Text

∙ To typeset two languages in parallel use the parallel package.

∙ Use the Parallel environment to switch to parallel formatting.

\begin{Parallel}{left width }{right width }

left width and right width are the widths of the left and right columns. These
can be absolute values, e.g. 2.5in, or relative values, e.g. 0.45\textwidth

The Parallel Environment

∙ Within the Parallel environment use:

\ParallelLText{left text }
\ParallelRText{right text }
\ParallelPar

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 14
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∙ left text and right text should be single paragraphs.

∙ Each set of \ParallelLText and \ParallelRText must be separated by \ParallelPar

Example 9.

\begin{Parallel}{0.42\textwidth}{0.42\textwidth}
\ParallelLText{Gallia est omnis divisa in partes tres,
quarum unam incolunt Belgae, aliam Aquitani, tertiam qui
ipsorum lingua Celtae, nostra Galli appellantur. Hi omnes
lingua, institutis, legibus inter se differunt.}

Left column

\ParallelRText{All Gaul is divided into three parts, one of
which the Belgae inhabit, the Aquitani another, those who are
in their own language are called Celts, in our Gauls, the
third. All these differ from each other in language, customs
and laws.}

Right
column

\ParallelPar
\ParallelLText{Gallos ab Aquitanis Garumna
flumen, a Belgis Matrona et Sequana dividit.}

Left
column

\ParallelRText{The river Garonne separates the Gauls from the
Aquitani, the Marne and the Seine separate them from the Belgae.}

Right column
\end{Parallel}

Gallia est omnis divisa in partes All Gaul is divided into three
tres, quarum unam incolunt Belgae, parts, one of which the Belgae in-
aliam Aquitani, tertiam qui ipsorum habit, the Aquitani another, those
lingua Celtae, nostra Galli appellan- who are in their own language are
tur. Hi omnes lingua, institutis, leg- called Celts, in our Gauls, the third.
ibus inter se differunt. All these differ from each other in

language, customs and laws.
Gallos ab Aquitanis Garumna flu- The river Garonne separates the

men, a Belgis Matrona et Sequana di- Gauls from the Aquitani, the Marne
vidit. and the Seine separate them from the

Belgae.

Exercise 8.

∙ Change your document so that it has two columns.

∙ If you want (and have time) try experimenting with the multicol or parallel

packages.

\begin{multicols}{2}
\lipsum[1]
\end{multicols}

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 15
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3.6 Bibliographies

Creating a Bibliography Manual Method
Use the thebibliography environment:

\begin{thebibliography}{1}
\bibitem{lamport94} Leslie Lamport.
\emph{\LaTeX\ : a document preparation system}.
Addison-Wesley, 2nd edition (updated for \LaTeXe),
1994.

\end{thebibliography}

Disadvantages:

∙ You have to remember to format the entries consistently.

∙ You need to sort the entries.

Creating a Bibliography Using BibTeX

∙ Entries are stored in one or more databases. You specify the database(s) using
\bibliography{database list } where you want the bibliography to appear.

∙ You specify the bibliography style using \bibliographystyle{style } (This gov-
erns the sorting as well as the formatting).

∙ Use the bibtex application to select only those references you’ve cited in the
document.

BibTeX

∙ Create a new file (with .bib extension).

∙ Enter the details of the reference using a special syntax. (Use TeXMaker’s Bibli-
ography menu to help you with the syntax.)

∙ BibTeX converts title text to lower case (depending on the style) except for the
first word. Enclose proper nouns in curly braces to prevent this.

∙ Each entry has a unique label. Choose a naming system you find easy to remember.

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 16
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BibTeX Database

Example 10.

@book

This reference is a book

{lamport94

label

,
author = "Leslie Lamport",
title = "{\LaTeX}

Don’t change to lower case!

: a document preparation
system",

edition = "2nd",
publisher = "Addison-Wesley",

year = 1994 Plain numbers don’t need quotes
}

You can also use curly braces instead of double quotes. For example:
author = {Leslie Lamport},

Multiple Authors

∙ Separate each author with and.

Example 11.

@inproceedings

This reference is a conference article

{smith05,
author = "John Smith, Jr and Jane Lucy Doe

and Jo de Vere",
title = "An example article",
booktitle = "Proceedings of the Imaginary Society",

month = JAN Use 3 letter abbreviation without quotes,
year = 2005

}

(If you use the three letter month abbreviations, the month name will either be ex-
panded or abbreviated, depending on the bibliography style.)

Citations

∙ By default, citations are numerical.

∙ For more flexibility use a bibliography package. Examples:

– natbib

– newapa

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 17
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– biblatex— new, very flexible.

∙ We will be using the natbib package with the plainnat bibliography style.

– Can choose between numerical and author year formats.

– Can have textual and parenthetical citations.

Other bibliography styles provided by the natbib package are abbrvnat and unsrtnat.

Example 12. Assume the bibliography database is called myrefs.bib:

\documentclass{scrartcl}

\usepackage{natbib}

Load bibliography package

\bibliographystyle{plainnat} Specify bibliography style

\begin{document}
Main matter with citations such as \citet{lamport94}

Citation

.

\bibliography{myrefs} This is where the bibliography will go
\end{document}

Citations (natbib)

∙ Textual citation: \citet[note ]{label }

Example 13.

\citet{lamport94} ⇒ Lamport (1994)
\citet[p.~34]{lamport94} ⇒ Lamport (1994, p. 34)

(Recall the tilde ~ is a non-breakable space.)

∙ Parenthetical citation: \citep[pre ][post ]{label }

Example 14.

\citep{lamport94} ⇒ (Lamport, 1994)
\citep[p.~34]{lamport94} ⇒ (Lamport, 1994, p. 34)
\citep[see][]{lamport94} ⇒ (see Lamport, 1994)

KOMA-Script
With the KOMA-Script classes you can:

∙ Add a preamble to the bibliography using

\setbibpreamble{preamble }

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 18
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∙ Add the bibliography to the table of contents using the class option bibtotoc

∙ Make the bibliography a numbered section/chapter using the class option bibtotocnumbered

Workflow

Edit
.tex
File

Edit
.bib
File

Any
Errors?

Any
Errors?

Any
Errors?

View
PDF

Remove .bbl file

LATEX
.tex file

Yes

Error in document

No errors.
Run BibTeX

Yes

Misspelt/missing label or bib style

Yes

Error in bib file

No errors.
Run LATEX

(twice)

Yes

No

You can remove the .bbl using TeXMaker’s Tools→Clean menu item.

Exercise 9. Create a bibliography for your document:

∙ Make a new file.

∙ Use the Bibliography menu to help create some references.

∙ Save the file.

∙ Use \citet or \citep in your document.

∙ Run pdflatex, bibtex, pdflatex, pdflatex and view the PDF file.

4 Multilingual Support

Multilingual Support

∙ Different languages have different hyphenation patterns.

∙ Predefined text, such as “Chapter” and “Contents”, should change if you are not
writing in English.

∙ Different languages use different quotation marks.

∙ Need to tell LATEX what language you are using if you’re not writing in English.

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 19
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Packages

∙ babel (supports 41 languages)

∙ translator

∙ polyglossia (XeLaTeX)

∙ Other packages for specific languages (e.g. arabtex, bangtex, cjk)

4.1 babel

Using babel

∙ Specify the languages in the class option. For example:

\documentclass[french,english]{scrartcl}

The last named language is the default language.

∙ Load babel:

\usepackage{babel}

∙ Use \selectlanguage{language } to switch to another language.

∙ Use \foreignlanguage{language }{text } to typeset a phrase in another lan-
guage.

Example 15.

\documentclass[latin,english

Languages used in this document

]{scrartcl}
\usepackage{babel} Load babel
\begin{document}
According to Horace, we should
\foreignlanguage{latin}{carpe diem}

Latin phraseor seize the day.

\selectlanguage{latin} Switch to Latin
Carpe diem, quam minimum credula postero.
\end{document}

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 20
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4.2 Symbols

Quote Marks

∙ Use csquotes to use language dependent quotation marks.

∙ Use the package option babel to ensure the quotation marks switch with the
language.

∙ Use \enquote{text } to quote some text.

∙ \enquote can be nested.

Example 16.

\documentclass[french,american,british]{scrartcl}
\usepackage[T1]{fontenc} Need to set the encoding
\usepackage{babel}
\usepackage[babel]{csquotes}
\begin{document}
\enquote{Hello,}

Single quotes

I said.

\selectlanguage{american}
\enquote{Hello,}

Double quotes

I said.

\selectlanguage{french}
\enquote{Bonjour,}

Guillemets

j’ai dit.
\end{document}

Diacritics

∙ If you use the inputenc package, you can directly enter the character using the
relevant keyboard combination.

∙ You must set the correct encoding. In the UK, this will typically be either latin1
or utf8.

∙ This will cause a problem if you are sharing your code with someone who uses a
different encoding.

Example 17.

\documentclass{scrartcl}
\usepackage[T1]{fontenc}
\usepackage[utf8]{inputenc}
\begin{document}
It’s naı̈ve to think that eating mouldy pâté
won’t result in food poisoning.
\end{document}
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Encoding Independent

∙ If you don’t want to use the inputenc package, you can use LATEX commands to
produce diacritics.

∙ In TeXMaker, you can use the LaTeX→ International Accents menu.

∙ Other diacritic commands are also available for particular symbols. Examples:

\O Ø \o ø
\AA Å \aa å
\L  L \l  l

Example 18.

It’s na\"ive to think that eating mouldy p\^at\’e
won’t result in food poisoning.

(On some older systems you’ll need to use \i or \j when putting accents on an i or j,
e.g. na\"{\i}ve.)

Ligatures

∙ The f-ligatures are converted automatically (ff, fl, fi, ffl, ffi).

∙ This can cause a problem searching a PDF when viewing on-line.

∙ Use the cmap package to make searching easier.

∙ Other ligatures can be obtained using LATEX commands. Examples:

\AE Æ \ae æ
\OE Œ \oe œ

Example 19.

His unwise man\oe uvre caused a h\ae morrhoid.

produces: His unwise manœuvre caused a hæmorrhoid.

Notes

∙ Can also write man\oe{}uvre and h\ae{}morrhoid but not man\oeuvre or h\aemorrhoid.

∙ A space or empty braces are needed to separate the command name from the rest
of the text.

A full list of symbols is available in the Comprehensive List of Symbols by Scott Pakin
at http://www.tex.ac.uk/tex-archive/help/Catalogue/entries/comprehensive.
html
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Exercise 10.

∙ Add the babel package to your document.

∙ Remember to specify the language(s) in the class options.

∙ If you’ve set the language to something other than English, have you noticed a
difference in the document?

5 Font Styles

5.1 Font Changes

Font Commands

∙ We’ve already used some font changing commands. For example \emph{simple}
emphasizes the word “simple”. This toggles italic and upright depending on the
surrounding font.

∙ In TeXMaker, you can use LaTeX→Font Styles to select the style you want (e.g.
\emph - Emphasis [selection])

∙ These commands are called text-block commands. They change the font for the
text given in the argument.

∙ To switch the font, you can use a declaration or an environment.

Font Declarations

\rmfamily Serif
\sffamily Sans-serif
\ttfamily Typewriter
\mdseries Medium weight
\bfseries Bold weight
\itshape Italic
\slshape Slanted
\upshape Upright
\scshape Small Caps
\em Emphasized
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Size Declarations

\Huge Huge
\huge huge
\LARGE LARGE
\Large Large
\large large
\normalsize normalsize
\small small
\footnotesize footnote size

\scriptsize scriptsize

\tiny tiny

Environments
Environments have the same name as the declarations without the leading backslash.

Example 20.

\normalfont
Some normal text.
\begin{large}\bfseries

Only has effect
until the end of
the environmentSome large bold text.

\end{large}
Some normal text.

Produces: Some normal text. Some large bold text. Some normal text.

Changing the Default Font

∙ Most classes use the serif font as the default.

∙ If you want the default font to be sans-serif or typewriter you need to redefine
\familydefault:

– For sans-serif do:

\renewcommand*{\familydefault}{\sfdefault}

– For typewriter do:

\renewcommand*{\familydefault}{\ttdefault}

∙ \normalfont will now use sans-serif or typewriter, respectively.
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Typesetting URLs

∙ Web addresses are typically typeset using a typewriter font.

∙ Web addresses sometimes contain TEX’s special characters.

∙ Web addresses are sometimes very long, but shouldn’t be hyphenated across a line
break.

∙ Can’t just use \texttt.

∙ Use hyperref or url packages:

\url{address }

5.2 Changing the Heading Fonts

Heading Fonts

∙ The KOMA-Script classes make it easy to change the font used in the headings.

∙ Use

\addtokomafont{type }{declarations }

where type indicates what you are changing.

Exercise 11. Change the section headings in your document to serif medium weight
italic:

\addtokomafont{section}{\rmfamily\mdseries\itshape}

6 Help

Package and Class Documentation

∙ Try using the texdoc application:

1. Go to the Start menu and then select Run. . .

2. Type texdoc followed by a space and then the name of the class or package.
For example: texdoc natbib

∙ Try going to the web address http://www.ctan.org/pkg/package-name where
package-name is the name of the package. For example: http://www.ctan.org/
pkg/natbib

∙ Try searching for the package in the TEX Catalogue: http://www.tex.ac.uk/
tex-archive/help/Catalogue/
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Links

∙ The UK TUG FAQ: http://www.tex.ac.uk/faq

∙ The TEX Users Group: http://www.tug.org/

∙ The LATEX Community: http://www.latex-community.org/

∙ comp.text.tex archives: http://groups.google.com/group/comp.text.tex/

∙ texhax archives: http://tug.org/pipermail/texhax/

∙ TeXMaker: http://www.xm1math.net/texmaker/

∙ My LATEX web page: http://theoval.cmp.uea.ac.uk/~nlct/latex/

Books

∙ Helmut Kopka and Patrick W. Daly. A Guide to LATEX. Addison-Wesley.

∙ Michel Goossens, Frank Mittelbach and Alexander Samarin. The LATEX Compan-
ion. Addison-Wesley.

∙ Leslie Lamport. LATEX: a Document Preparation System. Addison-Wesley.

http://theoval.cmp.uea.ac.uk/~nlct/latex/csed/ 26


	ctip Field 1: 
	ctip Field 2: 


